
 GUIDE TO THE O’LEARY SERIES

INTRODUCTION TO 
MICROSOFT OFFICE 2007

xvi

The O’Leary Series is full of features designed to make learning productive and hassle free. On the following 
pages you will see the kind of engaging, helpful pedagogical features that have helped countless students mas-
ter Microsoft Offi ce Applications.

WDO.1

Overview of Microsoft Office Word 2007

• What Is Word Processing?
Office Word 2007 is a word processing software application whose purpose
is to help you create any type of written communication. A word processor
can be used to manipulate text data to produce a letter, a report, a memo,
an e-mail message, or any other type of correspondence. Text data is any
letter, number, or symbol that you can type on a keyboard. The grouping of
the text data to form words, sentences, paragraphs, and pages of text
results in the creation of a document. Through a word processor, you can
create, modify, store, retrieve, and print part or all of a document.

Word processors are one of the most widely used application software
programs. Putting your thoughts in writing, from the simplest note to the
most complex book, is a time-consuming process. Even more time-consuming
is the task of editing and retyping the document to make it better. Word
processors make errors nearly nonexistent—not because they are not made,
but because they are easy to correct. Word processors let you throw away the
correction fluid, scissors, paste, and erasers. Now, with a few keystrokes, you
can easily correct errors, move paragraphs, and reprint your document.

• Word 2007 Features
Word 2007 excels in its ability to change or edit a document. Editing involves
correcting spelling, grammar, and sentence-structure errors. In addition, you
can easily revise or update existing text by inserting or deleting text. For
example, a document that lists prices can easily be updated to reflect new
prices. A document that details procedures can be revised by deleting old
procedures and inserting new ones. This is especially helpful when a
document is used repeatedly. Rather than recreating the whole document,
you change only the parts that need to be revised.

Revision also includes the rearrangement of selected areas of text. For
example, while writing a report, you may decide to change the location of
a single word or several paragraphs or pages of text. You can do it easily
by cutting or removing selected text from one location, then pasting or
placing the selected text in another location. The selection also can be
copied from one document to another.

To help you produce a perfect document, Word 2007 includes many
additional support features. The AutoCorrect feature checks the spelling
and grammar in a document as text is entered. Many common errors are
corrected automatically for you. Others are identified and a correction
suggested. A thesaurus can be used to display alternative words that have
a meaning similar or opposite to a word you entered. A Find and Replace
feature can be used to quickly locate specified text and replace it with
other text throughout a document. In addition, Word 2007 includes a

INTRODUCTION TO 
WORD 2007

Each text in the O’Leary Series 
also provides an overview of the 
specifi c application features.

• What Is the 2007 Microsoft Office System?
Microsoft’s 2007 Microsoft Office System is a comprehensive, integrated
system of programs, servers, and services designed to solve a wide array of
business needs. Although the programs can be used individually, they are
designed to work together seamlessly, making it easy to connect people and
organizations to information, business processes, and each other. The
applications include tools used to create, discuss, communicate, and
manage projects. If you share a lot of documents with other people, these
features facilitate access to common documents. This version has an
entirely new user interface that is designed to make it easier to perform
tasks and help users more quickly take advantage of all the features in the
applications. In addition, the communication and collaboration features
and integration with the World Wide Web have been expanded and refined.

The 2007 Microsoft Office System is packaged in several different
combinations of programs or suites. The major programs and a brief
description are provided in the following table.

I.2 Introduction to Microsoft Office 2007 www.mhhe.com/oleary
Word 2007

Program Description

Word 2007 Word Processor program used to create text-
based documents

Excel 2007 Spreadsheet program used to analyze
numerical data

Access 2007 Database manager used to organize, manage,
and display a database

PowerPoint 2007 Graphics presentation program used to create
presentation materials

Outlook 2007 Desktop information manager and messaging
client

InfoPath 2007 Used to create XML forms and documents

OneNote 2007 Note-taking and information organization
tools

Publisher 2007 Tools to create and distribute publications for
print, Web, and e-mail

Visio 2007 Diagramming and data visualization tools

SharePoint Designer 2007 Web site development and management for
SharePoint servers

Project 2007 Project management tools

Groove 2007 Collaboration program that enables teams to
work together

The four main components of Microsoft Office 2007—Word, Excel,
Access, and PowerPoint—are the applications you will learn about in this
series of labs. They are described in more detail in the following sections.

EASY TO FOLLOW INTRODUCTORY MATERIALS

Each text in the O’Leary Series opens with 
an Introduction to Offi ce 2007, providing 
a complete overview of this version of the 
Microsoft Offi ce Suite.
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OBJECTIVES

ENGAGING LAB INTRODUCTIONS

WD2.3

Formatting and page layout
changes such as margin
adjustments, indented
paragraphs, and tabbed
tables help improve the
readability and style of the
document.

Graphic enhancements such as shapes add interest
to a document.

Features such as the Spelling
Checker, Thesaurus, Move and
Copy, and Find and Replace make
it easy to revise and refine your
document.

After creating the rough draft of the new tours flyer,
you showed the printed copy to your manager at
Adventure Travel Tours. Your manager then made
several suggestions for improving the flyer’s style
and appearance. In addition, you created a letter to
be sent to clients along
with your flyer. The let-
ter briefly describes
Adventure Travel’s four
new tours and invites
clients to attend an
informational presenta-
tion. Your manager likes
the idea, but also wants
the letter to include
information about the
new Adventure Travel
Tours Web site and a 10
percent discount for
early booking.

In this lab, you will learn more about editing doc-
uments so you can reorganize and refine both your
flyer and a rough draft of the letter to clients. You
also will learn to use many more of the formatting
features included in Office Word 2007 so you can

add style and inter-
est to your docu-
ments. Formatting
features can greatly
improve the appear-
ance and design of
any document you
produce so that it
communicates its
message more
clearly. The com-
pleted letter and
revised flyer are
shown here.

Adventure Travel Tours

Case Study

WD2.2

Revising and Refining
a Document LAB 2

WD2.1

O b j e c t i v e s
After completing this lab, you will know how to:

•1
Use the Spelling and Grammar tool and the Thesaurus.

•2
Move, cut, and copy text and formats.

•3
Control document paging.

•4
Find and replace text.

•5
Insert the current date.

•6
Change indents, line spacing, and margins.

•7
Create a tabbed table.

•8
Add color highlighting and underlines.

•9
Create numbered and bulleted lists.

•10
Create and use Building Blocks.

•11
Insert and modify a shape.

•12
Edit in Print Preview.

•13
Print a document.

Each lab opens with a list of objectives clearly 
outlining skills covered in each lab.

Screen Shots of the completed lab allow you 
to preview what will be accomplished.

CASE STUDIES

Case studies introduce a real-life 
setting that is interwoven throughout 
the lab. Four separate running cases 
provide the basis for understanding 
the use of applicatons.
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WD2.6 Lab 2: Revising and Refining a Document www.mhhe.com/oleary
Word 2007

The Spelling and Grammar dialog box is displayed, and the spelling and
grammar checker has immediately located the first word that may be
misspelled, “paddleing.” The sentence with the misspelled word in red is
displayed in the Not in Dictionary text box, and the word is highlighted in
the document.

The Suggestions list box displays the words the spelling checker has
located in the dictionary that most closely match the misspelled word. The
most likely match is highlighted. Sometimes the spelling checker does not
display any suggested replacements. This occurs when it cannot locate
any words in the dictionaries that are similar in spelling. If no suggestions
are provided, the Not in Dictionary text box simply displays the word that
is highlighted in the text.

To change the spelling of the word to one of the suggested spellings,
highlight the correct word in the list and then click . If there
were no suggested replacements, and you did not want to use any of the
option buttons, you could edit the word yourself by typing the correction
in the Not in Dictionary box. In this case, the correct replacement,
“paddling,” is already highlighted.

Because the contents of the
list are determined only by
spelling, any instances of
terms that seem
inappropriate in context are
completely coincidental.

Additional Information

The option
replaces the same word
throughout the document
with the word you select in
the Suggestions box.

Additional Information

To correct the misspelled words and grammatical errors, you can use the
context menu to correct each individual word or error, as you learned in
Lab 1. However, in many cases, you may find it more efficient to wait until
you are finished writing before you correct errors. Rather than continually
breaking your train of thought to correct errors as you type, you can
manually turn on the spelling and grammar checker to locate and correct
all the errors in the document at once.

2 • Open the Review tab.

• Click .

Another Method

• If necessary, select the
Check grammar option
to turn on grammar
checking.

Your screen should be
similar to Figure 2.2

The keyboard shortcut is 7.
Another Method

Figure 2.2

You also can click the Spelling
and Grammar status icon 
to move to the next
spelling or grammar error
and open the spelling context
menu.

Additional Information

Starts
spelling
and grammar
check

Suggested
corrections

Turns grammar
checker
on or off

Identified misspelled word

NUMBERED AND BULLETED STEPS

Revising a Document WD2.5

Word 2007

1 • Start Office Word 2007
and open the file
wd02_Tour Letter.

• If necessary, change
to Print Layout view at
100% zoom.

Your screen should be
similar to Figure 2.1

Figure 2.1

Spell-Checking the Entire Document
The first correction you want to make is to clean up the spelling and
grammar errors that Word has identified.

Many spelling and
grammer errors
identified

Indent paragraphs

Add date

Find spelling and
grammar errors

Find a better word

Make tabbed table Increase spacing

Find and replace
with “tour”

Make bulleted list
and sort

Add closing

Numbered and bulleted steps provide 
clear step-by-step instructions on how 
to complete a task, or series of tasks.

All steps and bullets appear in 
the left hand margin, making 
it easy not to miss a step.

STEP-BY-STEP INSTRUCTION
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WD3.12 Lab 3: Creating Reports and Tables www.mhhe.com/oleary
Word 2007

To Collapse Do This

Text below a specific heading level Select the lowest heading you want to display from 
the drop-down menu.

All subheadings and body text under a heading Double-click next to the heading.

Text under a heading, one level at a time Click the heading text, and then click Collapse.

All body text Select the heading level you want to see from the
drop-down menu.

All body text except first line Click .

To Expand Do This

All headings and body text Select Show All Levels from the
drop-down menu.

All collapsed subheadings and body text 
under a heading Double-click next to the heading.

Collapsed text under a heading, 
one level at a time Click the heading text; then click Expand.

To change the amount of information displayed, you will collapse the
display of the text under the Geography and Climate heading first. Then
you will collapse everything below a level 3 heading so you can quickly
check the report organization.

1 • Double-click of the
Tanzania Geography
and Climate heading.

• Open the

drop-down list.

• Choose Level 3.

Your screen should be
similar to Figure 3.8

Figure 3.8

Three
levels
displayed

Specifies number of
outline levels to display

Wavy underlines
indicate collapsed heading

WD2.6 Lab 2: Revising and Refining a Document www.mhhe.com/oleary
Word 2007

The Spelling and Grammar dialog box is displayed, and the spelling and
grammar checker has immediately located the first word that may be
misspelled, “paddleing.” The sentence with the misspelled word in red is
displayed in the Not in Dictionary text box, and the word is highlighted in
the document.

The Suggestions list box displays the words the spelling checker has
located in the dictionary that most closely match the misspelled word. The
most likely match is highlighted. Sometimes the spelling checker does not
display any suggested replacements. This occurs when it cannot locate
any words in the dictionaries that are similar in spelling. If no suggestions
are provided, the Not in Dictionary text box simply displays the word that
is highlighted in the text.

To change the spelling of the word to one of the suggested spellings,
highlight the correct word in the list and then click . If there
were no suggested replacements, and you did not want to use any of the
option buttons, you could edit the word yourself by typing the correction
in the Not in Dictionary box. In this case, the correct replacement,
“paddling,” is already highlighted.

Because the contents of the
list are determined only by
spelling, any instances of
terms that seem
inappropriate in context are
completely coincidental.

Additional Information

The option
replaces the same word
throughout the document
with the word you select in
the Suggestions box.

Additional Information

To correct the misspelled words and grammatical errors, you can use the
context menu to correct each individual word or error, as you learned in
Lab 1. However, in many cases, you may find it more efficient to wait until
you are finished writing before you correct errors. Rather than continually
breaking your train of thought to correct errors as you type, you can
manually turn on the spelling and grammar checker to locate and correct
all the errors in the document at once.

2 • Open the Review tab.

• Click .

Another Method

• If necessary, select the
Check grammar option
to turn on grammar
checking.

Your screen should be
similar to Figure 2.2

The keyboard shortcut is 7.
Another Method

Figure 2.2

You also can click the Spelling
and Grammar status icon 
to move to the next
spelling or grammar error
and open the spelling context
menu.

Additional Information

Starts
spelling
and grammar
check

Suggested
corrections

Turns grammar
checker
on or off

Identified misspelled word

Tables provide quick summaries of 
concepts and procedures for specifi c 
tasks.

Large screen fi gures make it easy to 
identify elements and read screen 
content.

TABLES

FIGURES

SCREEN CALLOUTS

Meaningful screen callouts identify the 
results of the steps as well as reinforce 
the associated concept.

AND EASY-TO-FOLLOW DESIGN
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SUPPORTIVE MARGINAL NOTES

Additional Information offers brief 
asides with expanded coverage of 
content.

ADDITIONAL INFORMATION

ANOTHER METHOD

Another Method offers 
additional ways to perform a 
procedure.
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HAVING TROUBLE

Having Trouble helps resolve 
potential problems as you 
work through each lab.

MORE ABOUT

New to this edition, the More 
About icon directs students 
to the More About Appendix 
found at the end of each lab. 
Without interrupting the fl ow of 
the text, this appendix provides 
additional coverage required to 
meet MCAS certifi cation.

SUPPORTIVE MARGINAL NOTES (CONTINUED)
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Adventure Travel Tours provides information on their
tours in a variety of forms. Travel brochures, for instance,
contain basic tour information in a promotional format
and are designed to entice potential clients to sign up
for a tour. More detailed regional information packets
are given to people who have already signed up for a
tour, so they can prepare for their vacation. These pack-
ets include facts about
each region’s climate,
geography, and culture.
Additional informational
formats include pages
on Adventure Travel’s
Web site and scheduled
group presentations.

Part of your respon-
sibility as advertising
coordinator is to ga-
ther the information

that Adventure Travel will publicize about each re-
gional tour. Specifically, you have been asked to pro-
vide background information for two of the new
tours: the Tanzania Safari and the Machu Picchu trail.
Because this information is used in a variety of for-
mats, your research needs to be easily adapted. You
will therefore present your facts in the form of a gen-

eral report on Tan-
zania and Peru.

In this lab, you will
learn to use many of
the features of Office
Word 2007 that
make it easy to cre-
ate an attractive and
well-organized re-
port. A portion of
the completed re-
port is shown here.

Adventure Travel Tours

Case Study

WD3.2

Focus on Careers
EXPLORE YOUR CAREER OPTIONS

Food Service Manager
Have you noticed flyers around your campus
advertising job positions? Many of these jobs are in the
food service industry. Food service managers are
traditionally responsible for overseeing the kitchen and
dining room. However, these positions increasingly
involve administrative tasks, including recruiting new

employees. As a food service manager, your position
would likely include creating newspaper notices and
flyers to attract new staff. These flyers should be eye-
catching and error-free. The typical salary range of a
food service manager is $34,000 to $41,700. Demand
for skilled food service managers is expected to
increase through 2010.

Exiting Word WD1.71

Word 2007

The default range setting, All, is the correct setting. In the Copies
section, the default setting of one copy of the document is acceptable. You
will print using the default print settings.

2 • If you need to change the selected printer to another printer, open the Name drop-down list box and select the
appropriate printer (your instructor will tell you which printer to select).

• Click .

Your printer should be printing the document. The printed copy of the
flyer should be similar to the document shown in the Case Study at the
beginning of the lab.

• Exiting Word
You are finished working on the flyer for now and want to save the last 
few changes you have made to the document and close the Word applica-
tion. The command in the File menu is used to quit the Word 

program. Alternatively, you can click the Close button in the application
window title bar. If you attempt to close the application without first saving
your document, Word displays a warning asking if you want to save your
work. If you do not save your work and you exit the application, any
changes you made since last saving it are lost.

1 • Click Close.

• Click to save the changes you made to the file.

The keyboard shortcut 
for the Exit command is 
a + 4.

Another Method

The Windows desktop is visible again.
If multiple word documents are open, clicking closes the application

window containing the document you are viewing only.

FOCUS ON CAREERS

Focus on Careers provides an example of 
how the material covered may be applied in 
the “real world.”
Each lab highlights a specifi c career, 
ranging from Forensic Science technician 
to food services manager, and presents job 
responsibilities and salary ranges for each.

CONTINUING CASE STUDIES

Within each series application, the 
same Case Study is used to illustrate 
concepts and procedures.

REAL WORLD APPLCIATION
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AND INTEGRATION

Working Together 1:
Word 2007 and

Your Web Browser

WDWT1.1

The Adventure Travel Tours Web site is used to pro-
mote its products and broaden its audience of cus-
tomers. In addition to the obvious marketing and
sales potential, it provides an avenue for interaction
between the company and the customer to improve
customer service. The company also uses the Web
site to provide articles of interest to customers. The
articles, which include topics such as travel back-
ground information and descriptions, changes on a
monthly basis as an added incentive for readers to re-
turn to the site.

You want to use the flyer you developed to pro-
mote the new tours and presentations on the Web

site. To do this, you will use Word 2007’s Web-editing
features that help you create a Web page quickly and
easily. While using the Web-editing features, you will
be working with Word and with a Web browser appli-
cation. This capability of all 2007 Microsoft Office ap-
plications to work together and with other applications
makes it easy to share and exchange information be-
tween applications. Your completed Web pages are
shown here.

Note: The Working Together tutorial is designed to
show how two applications work together and to
present a basic introduction to creating Web pages.

Case Study
Adventure Travel Tours

WORKING TOGETHER LABS

At the completion of the brief 
and introductory texts, a fi nal lab 
demonstrates the integration of MS 
offi ce applications. Each Working 
Together lab contains a complete set 
of end-of-chapter materials.

WDWT1.12 Working Together 1: Word 2007 and Your Web Browser www.mhhe.com/oleary
Word 2007

2 • Switch to the New
Tour Presentations
window.

• Add the following text
to the end of the last
paragraph: Find out
about presentation
locations, dates, and
times.

• Select the text
“locations, dates, and
times.”

• Open the Insert tab.

• Select
from the Links group.

Your screen should be
similar to Figure 12

The keyboard shortcut
is c + K.

Another Method

Figure 12

From the Insert Hyperlink dialog box, you need to specify the name of the
document you want the link to connect to.

3 • Select Tour
Locations.htm from
the file list.

• Click .

• Save the document.

Your screen should be
similar to Figure 13

Figure 13

Create hyperlink

Text to be used as
hyperlink

Select document
to link to

Hyperlink formatted
in theme colors

step-by-step

Adding a New Web Page ★
1. You want to continue working on the Web pages about the new tour presentations for the

Adventure Travel Web site. Your next step is to create links from each location on the Presentation
Locations Web page to information about each location’s presentation date and times. Your
completed Web page for the Los Angeles area should be similar to the one shown here.

a. In Word, open the
Web page file Tour
Locations you
created in this lab.

b. Open the document
wdwt_LosAngeles.
Save the document
as a Web page to
the ATT Web Page
folder with the 
file name LosAngeles
and a page title 
of Los Angeles
Presentation
Information.

c. Change the page
color to a gradient
fill effect of your
choice. Change the
first title line to the
Title style and the
second title line to
a Heading 1 style. Change the title lines to a color of your choice.

d. Increase the font size of the table to 12 points. Add color to the table headings. Enhance the Web
page with any features you feel are appropriate.

e. Two lines below the table, add the text Contact [your name] at (909) 555-1212 for more information.
Apply the Emphasis style to this line and increase the font size to 14 points.

f. On the Tour Locations page, create a link from the Los Angeles text to the Los Angeles page. Test
the link.

g. Resave both Web pages and preview them in your browser. Print the Los Angeles Web page.

h. Exit the browser and Word.

L a b  E x e r c i s e s

Easy

Moderate

Difficult

rating system

★★★

★★

★

CO
NTINUING

E XER C IS ES

Lab Exercises WDWT1.19

Word 2007
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• Introducing Office Word 2007
Adventure Travel Tours has recently upgraded their computer systems at
all locations across the country. As part of the upgrade, they have installed
the latest version of the Microsoft Office 2007 suite of applications. You
are very excited to see how this new and powerful application can help
you create professional letters and reports as well as eye-catching flyers
and newsletters.

Starting Office Word 2007
You will use the word processing application Microsoft Office System,
Word 2007, to create a flyer promoting the new tours and presentations.

WD1.4 Lab 1: Creating and Editing a Document www.mhhe.com/oleary
Word 2007

•1 Grammar Checker The grammar checker advises you of incorrect grammar as you create and
edit a document, and proposes possible corrections.

•2 Spelling Checker The spelling checker advises you of misspelled words as you create and edit
a document, and proposes possible corrections.

•3 AutoCorrect The AutoCorrect feature makes some basic assumptions about the text you are
typing and, based on these assumptions, automatically corrects the entry.

•4 Word Wrap The word wrap feature automatically decides where to end a line and wrap text to
the next line based on the margin settings.

•5 Font and Font Size Font, also commonly referred to as a typeface, is a set of characters with a
specific design that has one or more font sizes.

•6 Alignment Alignment is the positioning of text on a line between the margins or indents.
There are four types of paragraph alignment: left, centered, right, and justified.

•7 Graphics A graphic is a nontext element or object such as a drawing or picture that can be
added to a document.

C o n c e p t  P r e v i e w
The following concepts will be introduced in this lab:

CONCEPT PREVIEW

Concept Previews provide an overview to the 
concepts that will be presented throughout 
the lab.

CONCEPT BOXES

Concept boxes appear throughout 
the lab providing clear, concise 
explanations and serving as a 
valuable study aid.

REINFORCED CONCEPTS
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REINFORCED CONCEPTS (CONTINUED)

C o n c e p t  S u m m a r y

L A B 1
Creating and Editing a Document 

The spelling checker advises you of
misspelled words as you create and edit
a document, and proposes possible
corrections.

Spelling Checker (WD1.19)

The grammar checker advises you of
incorrect grammar as you create and
edit a document, and proposes possible
corrections.

Grammar Checker (WD1.16)

WD1.72 Lab 1: Creating and Editing a Document www.mhhe.com/oleary
Word 2007

The AutoCorrect feature makes some
basic assumptions about the text you are
typing and, based on these assumptions,
automatically corrects the entry.

AutoCorrect (WD1.21)

Grammar Checker

Spelling Checker

AutoCorrect

CONCEPT SUMMARIES

The Concept Summary offers a visual 
summary of the concepts presented 
throughout the lab.

The word wrap feature automatically
decides where to end a line and wraps
text to the next line based on the
margin settings.

Word Wrap (WD1.23)

A font, also commonly referred to as a
typeface, is a set of characters with a
specific design that has one or more
font sizes.

Fonts and Font Size (WD1.46)

Alignment is the positioning of text on a
line between the margins or indents.
There are four types of paragraph
alignment: left, centered, right, and
justified.

Alignment (WD1.56)

A graphic is a nontext element or object
such as a drawing or picture that can be
added to a document.

Graphics (WD1.59)

Concept Summary WD1.73

Word 2007

Word Wrap

Fonts and font size

Alignment

Graphics
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xxvi

END-OF-CHAPTER 
MATERIALS

Lab Exercises reinforce the terminology and 
concepts presented in the lab through Screen 
Identifi cation, Matching, Multiple Choice, True/
False, and Fill-in questions.

KEY TERMS

command summary

Lab Review WD1.75

Word 2007

Command Shortcut Action

Office Button Opens file menu

New c + N Opens new blank document

Open c + O Opens existing document file

Save c + S Saves document using same file name

Save As Saves document using a new file name, type, and/or location

Print c + P Prints document

Prepare/Properties Opens Document Information Panel

Close c + 4 Closes document

a + 4 Exit Word application

Quick Access Toolbar

Save c + S Saves document using same file name

Undo c + Z Restores last editing change

Redo c + Y Restores last Undo or repeats last command or action

Home tab

Font Group
Font Changes typeface

Size Changes font size

Clear Formatting Remove all formatting from selection

Bold c + B Adds/removes bold effect

c + I Adds/removes italic effect

Change Case Changes case of selected text

Color Changes text to selected color

Paragraph group

Show/Hide c + S +* Displays or hides formatting marks

Align Text Left c+ L Aligns text to left margin

Center c + E Centers text between left and right margins

Align Text Right c + R Aligns text to right margin

Justify c + J Aligns text equally between left and right margins

Insert Tab

Illustrations group

Inserts selected picture

Lab Exercises WD1.77

Word 2007

screen identification

1. In the following Word screen, letters identify important elements. Enter the correct term for each
screen element in the space provided.

L a b  E x e r c i s e s

Possible answers for the screen identification are:

Scrolls down
Draft view
Tab mark
Ribbon
Save
Print layout view
Font color
Font
Undo
Show/Hide
Close

Zoom
Center
Spelling and grammar

status icon
Redo
Bold
Status bar
Scroll bar
Graphic
Paragraph mark
Ruler

A. __________________
B. ___________________
C. ___________________
D. ___________________
E. ___________________
F. ___________________
G. ___________________
H. ___________________
I. ___________________
J. ___________________

K. ___________________
L. ___________________
M. ___________________
N. ___________________
O. ___________________
P. ___________________
Q. ___________________
R. ___________________
S. ___________________

S

A

B
G H

L

K

M

PQ O

C D E F
I

N

R

J

matching

Match the item on the left with the correct description on the right.

1. ________ a. undoes last command

2. font ________ b. moves to the top of the document

3. sans serif ________ c. feature that automatically begins a new line when text reaches the
right margin

4. alignment ________ d. pictures and clip art

5. c + h ________ e. shows dialog box

6. graphics ________ f. type style that can be applied to text

7. ________ g. font size measurement

8. word wrap ________ h. controls paragraph positioning between the margins

9. point ________ i. saves a document using the same file name

10. ________ j. font without a flair at the base of each letter

L a b  E x e r c i s e s

WD1.78 Lab 1: Creating and Editing a Document www.mhhe.com/oleary
Word 2007

Circle the correct response to the questions below.

1. Document development follows these steps.

a. plan, edit, enter, format, preview, and print

b. enter, edit, format, preview, and print

c. plan, enter, edit, format, preview, and print

d. design, enter, edit, format, preview, and print

2. The feature makes some basic assumptions about the text entered and automatically makes
changes based on those assumptions.

a. AutoChange

b. AutoFormat

c. AutoText

d. AutoCorrect

multiple choice

L a b  E x e r c i s e s

WD1.80 Lab 1: Creating and Editing a Document www.mhhe.com/oleary
Word 2007

true/false

Circle the correct answer to the following questions.

1. A wavy red line indicates a potential spelling error. True False

2. Hard spaces are used to justify text on a line. True False

3. The default document settings are stored in the Normal.docx file. True False

4. The D key erases the character to the right of the insertion point. True False

5. The automatic word wrap feature checks for typing errors. True False

6. The Word document file name extension is .wrd. True False

7. Font sizes are measured in inches. True False

8. Word inserts hidden marks into a document to control the display of text. True False

9. The AutoCorrect feature automatically identifies and corrects certain 
types of errors. True False

10. A selected picture is surrounded by a selection rectangle and eight 
moving handles. True False

9. A set of characters with a specific design is called a(n) _____________________.

a. style

b. font

c. AutoFormat

d. Design

10. A(n) _____________________ is text or pictures that appear behind document text.

a. graphic

b. watermark

c. embedded object

d. thumbnail

COMMAND SUMMARY

Includes a list of all bolded 
terms with page references.

Command Summaries provide a table of commands and 
keyboard and toolbar shortcuts for all commands used 
in the lab.

 LAB REVIEW        
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xxvii

Step-by-Step

Asking for Input Memo ★

1. Adventure Travel Tours is planning to update its Web site in the near future. You have been asked
to solicit suggestions from the travel agents about changes they would like to see made to the
current Web site. You decide to send all the travel agents a memo asking them for their input.
Your completed memo will be similar to the one shown here.

a. Open a blank Word
2007 document and
create the following
memo in Draft view.
Press T twice after
you type the colons (:)
following To in the
memo header. Press
T once after the
From and Date lines.
This will make the
information following
the colons line up
evenly. Enter a blank
line between
paragraphs.

To: Travel Agents
From: Student Name
Date: [Current date]

The Adventure Travel Tours current Web site was designed with travel agents in mind but as you know, the
role of the travel agent is changing. In order to keep up with these changes we plan to begin work on
updating the current Adventure Travel Tours Web site. In preparation for this project, I would like your input
about the content that will only be available to travel agents. As you work with clients please note what can
be changed to make it easier for you to book travel, then send your comments back to me. All suggestions
for changes are welcome and will be considered for our improved Web site.

Thank you in advance for your input.
b. Correct any spelling and grammar errors that are identified.

c. Turn on the display of formatting marks. Check the document and remove any extra blank
spaces between words or at the end of lines.

d. Save the document as Web Site Memo in your data file location.

e. Switch to Print Layout view.

f. End the first sentence after the word “mind”. Capitalize the following word, but. Insert the text

L a b  E x e r c i s e s

Hands-On Exercises
Easy

Moderate

Difficult

rating system

★★★

★★

★

WD1.82 Lab 1: Creating and Editing a Document www.mhhe.com/oleary
Word 2004

ON YOUR OWN

  AND SKILL DEVELOPMENT

LAB EXERCISES

These exercises have a rating system from easy to diffi cult 
and test your ability to apply the knowledge you have gained 
in each lab. Exercises that build off of previous exercises are 
noted with a  Continuing Exercise icon.

Lab Exercises provide hands-on practice and develop critical 
thinking skills through step-by-step and on-your-own practice 
exercises. Many cases in the practice exercises tie to a running 
case used in another application lab. This helps demonstrate the 
use of the four applications across a common case setting. For 
example, the Adventure Tours case used in Word is continued 
in practice exercises in Excel, Access, and PowerPoint.

L a b  E x e r c i s e s

WD1.88 Lab 1: Creating and Editing a Document www.mhhe.com/oleary
Word 2007

on your own

Creating a Flyer ★

1. Adventure Travel Tours is offering a great deal on a Day of the Dead Bicycle Tour in Mexico.
Research the Day of the Dead celebration using the Web as a resource. Then, using the features of
Word you have learned so far, create a flyer that will advertise this tour. Be sure to use at least two
colors of text, two sizes of text, and two kinds of paragraph alignment. Include a graphic from the
Clip Organizer. Include your name at the bottom of the flyer. Include your name in the file
properties as author and the file name as the title. Save the document as Mexico Adventure.

Creating a Swimming Pool Rules Flyer ★★

2. You work in the community pool and have been asked to create a flyer to post that identifies the rules
swimmers should follow when using the pool. Create a flyer that explains the five most important
rules to follow while swimming at the pool. Use a piece of clip art to liven up your flyer. Include
different font sizes, paragraph alignments, and other formatting features to make the flyer attractive.
Apply different font colors for each rule. Include a page border. Include your name at the bottom of
the flyer. Include your name in the file properties as author and the file name as the title. Save the
document as Pool Rules.

Astronomy Class Memo ★★

3. The city of Gilbert, Arizona, has recently built a $100,000 observatory that includes a $20,000
telescope in a local park. The observatory is open evenings for small groups of five to six people to
take turns looking through the 16-inch telescope’s eyepiece. The use of the observatory is free.

The city has decided to offer classes for the community to learn how to use the telescope and to
teach about astronomy. As a trial run, the class will first be offered to city employees and their families.
You want to notify all employees about the observatory and the class by including a memo with their
paycheck. Using Hands-On Exercise 1 as a model, provide information about when and where the
class will be held. Include information about how people sign up for the class. Include your name in
the file properties as author and the file name as the title. Save the memo as Astronomy Basics.

Volunteer Opportunities ★★★

4. Many community groups, hospitals, libraries, and churches are looking for volunteers to assist in
their programs. Volunteering has rewards for both the volunteer and the community. Using the
Web as a resource, research volunteer opportunities in your community. Then write a one-page
report that includes information about two volunteer groups for which you would like to
volunteer. Include information about what the organization does for the community. Also include
the skills you have to offer and the amount of time you can commit as volunteer. Include a title at
the top of the document and your name and the current date below the title. Center the title lines.
Use at least two colors of text, two sizes of text, and two kinds of paragraph alignment. Include a
graphic from the Clip Organizer. Include your name in the file properties as author and the file
name as the title. Save the document as Volunteer Opportunities.

Writing a Career Report ★★★

5. Using the library or the Web, research information about your chosen career. Write a one-page report
about your findings that includes information on three areas: Career Description; Educational
Requirements; Salary and Employment projections. Include a title at the top of the document and your
name and the current date below the title. Center the title lines. Justify the paragraphs. Include your
name in the file properties as author and the file name as the title. Save the document as Career Report.

Easy

Moderate

Difficult

rating system

★★★

★★

★
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END OF BOOK RESOURCES

WDCS.2 2007 Word Brief Command Summary www.mhhe.com/oleary
Word 2007

Command Shortcut Action

Font Group
Font Changes typeface

Size Changes font size

Grow Font Increases font size

Clear Formatting Clears all formatting from selected text, leaving plain text

Bold c + B Makes selected text bold

Italic c + I Applies italic effect to selected text

Underline c + U Adds underline below selected text

Change Case Changes case of selected text

Text Highlight Color Applies highlight color to selection

Font Color Changes selected text to selected color

Paragraph group
Bullets Creates a bulleted list

Numbering Creates a numbered list

Indents and Spacing Indents paragraph from left margin

Sort Rearranges items in a selection into ascending
alphabetical/numerical order

Show/Hide c + S + * Displays or hides formatting marks

Align text Left c + L Aligns text to left margin

Center c + E Centers text between left and right margins

Align text Right c + R Aligns text to right margin

Justify c + J Aligns text equally between left and right margins

Line Spacing c +  # Changes amount of white space between lines

Styles Group
More Opens Quick Styles gallery

Editing Group
c + F Locates specified text

c + H Locates and replaces specified text

Insert tab

Pages group
Inserts a preformatted cover page

Inserts a blank page

c + E Inserts a hard page break

Tables group

Inserts a table

2007 Word Brief
Command Summary

Command Shortcut Action

Office Button Opens File menu

New c + N Opens new document

Open c + O Opens existing document file

Save c + S, Saves document using same file name

Save As Saves document using a new file name, type, and/or
location

Save as/Save As type/ Saves file as a Web page document
Web Page

Print c + P Specify print settings before printing document

Print/Print Preview Displays document as it will appear when printed

Print/Quick Print Prints document using default printer settings

Prepare/Properties Opens document information panel

Close c + 4 Closes document

/Proofing Changes settings associated with Spelling and
Grammar checking

/Advanced/ Checks for formatting inconsistencies
Mark formatting
inconsistencies

a + 4, Closes the Word application

Quick Access Toolbar

Save Saves document using same file name

Undo c + Z Restores last editing change

Redo c + Y Restores last Undo or repeats last command or action

Home tab

Clipboard Group
Cut c + X Cuts selection to Clipboard

Copy c + C Copies selection to Clipboard

Paste c + V Pastes item from Clipboard

Format Painter Copies format to selection

2007 Word Brief Command Summary WDCS.1

Word 2007

Glossary of Key Terms 

active window The window containing the
insertion point and that will be affected by any
changes you make.

alignment How text is positioned on a line
between the margins or indents. There are four
types of paragraph alignment: left, centered,
right, and justified.

antonym A word with the opposite meaning.
author The process of creating a Web page.
AutoCorrect A feature that makes basic

assumptions about the text you are typing and
automatically corrects the entry.

bibliography A listing of source references that
appears at the end of the document.

browser A program that connects you to
remote computers and displays the Web pages
you request.

building blocks Document fragments that
include text and formatting and that can be
easily inserted into a document.

bulleted list Displays items that logically fall
out from a paragraph into a list, with items
preceded by bullets.

caption A title or explanation for a table,
picture, or graph.

case sensitive The capability to distinguish
between uppercase and lowercase characters.

cell The intersection of a column and row
where data are entered in a table.

character formatting Formatting features
such as bold and color that affect the selected
characters only.

citations Parenthetical source references that
give credit for specific information included in
a document.

Click and Type A feature available in Print
Layout and Web Layout views that is used to
quickly insert text, graphics, and other items in

a blank area of a document, avoiding the need
to enter blank lines.

clip art Professionally drawn graphics.
control A graphic element that is a container

for information or objects.
cross-reference A reference in one part of a

document related to information in another
part.

cursor The blinking vertical bar that shows
you where the next character you type will
appear. Also called the insertion point.

custom dictionary A dictionary of terms you
have entered that are not in the main
dictionary of the spelling checker.

default The initial Word document settings
that can be changed to customize documents.

destination The location to which text is
moved or copied.

Document Map A feature that displays the
headings in the document in the navigation
window.

document properties Details about a
document that describe or identify it and are
saved with the document content.

document theme A predefined set of
formatting choices that can be applied to an
entire document in one simple step.

document window The area of the application
window that displays the contents of the open
document.

drag and drop A mouse procedure that moves
or copies a selection to a new location.

drawing layer The layer above or below the
text layer where floating objects are inserted.

drawing object A simple object consisting of
shapes such as lines and boxes.

edit The process of changing and correcting
existing text in a document.

Glossary of Key Terms WDG.1

Word 2007

COMPREHENSIVE COMMAND SUMMARY

Provides a table of commands and keyboard 
and toolbar shortcuts for all commands used 
throughout the entire text.

GLOSSARY

Bolded terms found throughout the text are 
defi ned in the glossary.
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WDA.2 Appendix: More about Word 2007 www.mhhe.com/oleary
Word 2007

RESTORE TEMPLATE THEMES

Many times after applying a different theme or customizing a theme, you may
decide you want to restore the default document theme. Use the following
steps to restore the theme associated with the template you are using:

1 • Open the Page Layout tab.

• Click and choose Reset to Theme from Template in the Themes menu.

The theme associated with the template file you are using is reapplied to the
entire document.

CHANGE THEME COLORS

Each theme has a color scheme that consists of a set of 12 theme colors that are
applied to different elements of the theme. To customize a theme, you can apply
a different built-in color scheme to your selected theme or customize the theme’s
color scheme by changing the colors associated with the different elements. The
new color scheme can then be saved as a Custom Theme Color and can then be
quickly applied to other themes. Follow these steps to change theme colors:

1 • Open the Page Layout tab.

• Click and choose a theme of your choice.

• Click Theme Colors.

• Choose Create New Theme Colors.

The Theme Colors dialog box identifies the colors associated with the different
elements. The Sample box shows where the selected colors are used in a docu-
ment. Theme colors contain four text and background colors, six accent col-
ors, and two hyperlink colors.

2 • Click the button of the theme color element that you want to change.

• Choose the color that you want to use.

• In the same manner, select and change colors for all of the theme color elements that you want to change.

The Sample box reflects the new colors you selected so you can see the effect
of the changes that you make. Once you are satisfied with your selections, you
save the color scheme.

3 • In the Name text box, type a name that will identify the color scheme.

• Click .

The custom theme color name appears at the top of the Theme Colors menu so
you can quickly select and apply it to other themes.

To return all theme color
elements to their original
theme colors, you can click
Reset before you click Save.

Additional Information

MORE ABOUT WORD 2007

1. CREATING AND CUSTOMIZING DOCUMENTS

1.1 CREATE AND FORMAT DOCUMENTS

SET THEMES AS DEFAULT

Whenever you start Microsoft Office Word 2007, the Normal.dotm template
opens. It includes default settings such as margins, page size, and theme that
determine the basic look of a document. You can change the settings in the
Normal.dotm template so that whenever a new document is opened, the set-
tings you specified are used in all new documents you create. To change the
default theme from the Office theme to another, follow these steps:

1 • Click Office Button.

• Choose Open.
Do one of the following:
In Microsoft Windows Vista:

• Choose Templates, and then double-click the Normal.dotm file to open it.

In Microsoft Windows XP or Microsoft Windows Server 2003:

• Click Templates next to File name.

• Double-click Normal.dotm to open it.

The default document template file is opened and Normal.dotm appears in the
Word title bar. This file can be modified like any other file. Next, to change the
theme associated with the default document template,

2 • Open the Page Layout tab.

• Click and select a built-in theme of your choice or create your own custom theme.

If you wanted, you also could make changes to the fonts, margins, spacing, and
other settings. Once you are done and the file contains the settings you want the
Normal.dotm to include, you save the changes you have made to the template.

3 • Click Office Button and choose Save.

• Save the document as Normal.dotm to replace the contents of the template file with the new settings you
specified.

Next time you open a new blank document, the new settings you specified will
be the default document settings.

Creating and Customizing Documents WDA.1

Word 2007

If no templates are listed in the
Open dialog box, open the
Files of type list box, and then
choose All Word Templates.

Having Trouble?

Appendix
MORE ABOUT APPENDICES

A more about Appendix appears at 
the end of the brief and introductory 
texts. This appendix offers students 
additional coverage needed to meet 
MCAS requirements. Skills pertaining 
to additional MCAS coverage are 
denoted by a more about icon in the 
margins of the text.

Reference 1
Data File List

Reference 1 WDR1.1

Word 2007

Use Create

Lab 1

wd01_Flyer1.docx

wd01_Lions.wmf Flyer.docx

wd01_Parrot.wmf Flyer1.docx

Step-by-Step

1. Web Site Memo.docx

2. wd01_Child on Bike.wmf Bike Event.docx

3. wd01_Coffee.wmf Grand Re-Opening.docx

4. wd01_Note Taking Skills.docx Note Taking Skills.docx

5. wd01_History of Ice Cream.docx Ice Cream History.docx

wd01_Ice Cream.wmf

On Your Own

1. Mexico Adventure.docx

2. Pool Rules.docx

3. Astronomy Basics.docx

4. Volunteer Opportunities.docx

5. Career Report.docx

Lab 2

wd02_Tour Letter.docx Tour Letter2

wd02_Flyer2.docx

Step-by-Step

1. wd02_Note Taking Tips.docx Note Taking Skills2.docx

Note Taking Skills.docx (Lab 1)

2. wd02_Water Conservation.docx Water Conservation Column.docx

wd02_Conservation Tips.docx

wd02_Water Hose

3. wd02_Fitness Fun.docx Fitness Fun Flyer.docx

4. Conference Volunteers.docx

5. wd02_Coffee Flyer.docx Weekly Specials.docx

REFERENCE 1 - DATA FILE LIST

Reference 2
Microsoft Certified Applications Specialist (MCAS)

Reference 2 WDR2.1

Word 2007

Microsoft Office Word 2007

The Microsoft Certified Applications Specialist (MCAS) certification
program is designed to measure your proficiency in performing basic
tasks using the Office 2007 applications. Getting certified demonstrates
that you have the skills and provides a valuable industry credential for
employment.

After completing the labs in the Microsoft office Word 2007 Brief
edition, you have learned the following MCAS skills:

Description Lab

1. Creating and Customizing Documents

1.1 Create and Format documents

Work with templates Lab 1

Apply Quick Styles to documents Lab 3

Format documents by using themes Lab 3, More About

Customize themes Lab 3, More About

Format document backgrounds Lab 1

Insert blank pages or cover pages Lab 3

1.2 Layout Documents

Format Pages Lab 1, 2, More About

Create and modify headers and footers Lab 3

1.3 Make Documents and content Easier to find

Create, modify, and update tables of contents Lab 3, More About

Create, modify, and update indexes More About

Modify document properties Lab 1

Insert document navigation tools Lab 3, Working together 1

1.4 Personalize Office Word 2007

Customize Word options Lab 1

The data fi le list is a reference guide 
that helps organize data and solution 
fi les. It identifi es the names of the 
original and saved fi les.

REFERENCE 2 - MCAS 
CERTIFICATION GUIDE

Links all MCAS objectives to text 
content and end of lab exercises. 
You will always know which MCAS 
objectives are being covered. 
Introductory texts are MCAS 
certifi ed.
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ONLINE LEARNING CENTER (OLC)

www.mhhe.com/oleary

The Online Learning Center follows The O’Leary Series lab by lab, offering all kinds of supplementary help 
for you. OLC feature include:

• Learning Objectives

• Student Data Files

• Chapter Comptencies

• Chapter Concepts

• Self-grading Quizzes

• Additional Web Links
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